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4 Das Projekt Digitaluhr

Im letzten Kapitel hast du untersucht, was Objekte sind und wie diese
implementiert werden. Dabei hast du Datenfelder, Konstruktoren und Methoden
kennen gelernt. Weiterhin hast du gesehen, wie Objekte einer Klasse eine
gemeinsame Aufgabe erledigen konnen.

Nun wirst du die Zusammenarbeit von Objekten zweier verschiedener Klassen
kennen lernen.

Dieses Projekt wird eine Digitaluhr sein. Du modellierst eine 24-Stunden-
Anzeige, wobei Stunden und Minuten durch einen Doppelpunkt voneinander
getrennt sind.

| 10:15 |

Abbildung 4.1: Anzeige einer Digitaluhr

4.1 Erstellung eines Modells
Zuerst wirst du nun das Modell einer Digitaluhr entwerfen.

Die Digitalanzeige kannst du auffassen als zwei getrennte Anzeigen. Die eine
Anzeige erstellt ein Ziffernpaar fiir die Stunden, die andere ein Ziffernpaar fiir
die Minuten, und beide Anzeigen sind getrennt durch einen Doppelpunkt.

Uhrenanzeige

‘ 10 : 15
/! "\
15

Nummernanzeige

Abbildung 4.2: Modellierung einer Digitalanzeige
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Die Nummernanzeige fiir die Stunde startet bei 0, wird jede Stunde um 1 erhoht,
bis sie 23 erreicht und wieder auf O zuriickspringt.

Die Nummernanzeige fiir die Minute startet bei 0, wird jede Minute um 1
erhoht, bis sie 59 erreicht und wieder auf 0 zurtickspringt.

Du erkennst, dass die Aufgaben dieser beiden Nummeranzeigen identisch sind.
Diese Aufgaben werden in der Klasse Nummernanzeige erledigt. Dazu bendtigst
du zwei Datenfelder:

limit an dem die Anzeige wieder auf 0 zuriick springt,
wert das den aktuellen Anzeigewert beinhaltet.
stunden minuten
it it
wert wert

Abbildung 4.3: Objekte stunden und minuten der Klasse Nummernanzeige

public class Nummernanzeige

{

private int limit;

private int wert;

// Konstruktor und Methoden hier ausgelassen
ks

Abbildung 4.4: Datenfelder der Klasse Nummernanzeige

Den Rest wirst du spdter kennen lernen.

Nun zur Klasse Uhrenanzeige. Diese Klasse muss die beiden Nummernanzeigen
fiir die Stunden und fiir die Minuten enthalten. Du definierst also in der Klasse
Uhrenanzeige zwei Datenfelder stunden und minuten vom Typ
Nummernanzeige. Du benutzt also die Klasse Nummernanzeige als den Typ fiir
die Datenfelder stunden und minuten.

Der Typ eines Datenfelds legt also fest, welche Arten von Werten in dem
Datenfeld gespeichert werden konnen. Wenn der Typ eine Klasse ist, kann das
Datenfeld Objekte dieser Klasse enthalten.

public class Uhrenanzeige

{

private Nummernanzeige stunden;
private Nummernanzeige minuten;

// Konstruktor und Methoden hier ausgelassen
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Abbildung 4.5: Datenfelder der Klasse Uhrenanzeige

meinellhr Murnane manze1ge
stmden [ —] r 10
Iminuten
Zeitanzeige %\ :
\ Nurnme manze 1ge
A

Abbildung 4.6: Objektdiagramm fiir eine Uhrenanzeige

Beachte, dass du mit zwei Klassen arbeitest, das Objektdiagramm jedoch drei
Objekte anzeigt. Du erzeugst nimlich von der Klasse Nummernanzeige zwei
Objekte.

Um nun diese Anwendung zu starten, wird ein Objekt meineUhr der Klasse
Uhrenanzeige erzeugt. Dieses erzeugt automatisch zwei Objekte stunden und
minuten der Klasse Nummernanzeige.
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Abbildung 4.7: Klassen Uhrenanzeige und Nummernanzeige in BlueJ

Das Modell der Digitaluhr ist nun entworfen. Nun werden wirst du dich der
Implementierung dieses Modells widmen.

4.2 Die Klasse Nummernanzeige
Was muss die Klasse Nummernanzeige alles konnen?

1. Sie muss den aktuellen Anzeigewert liefern: gibWert()
2. Sie muss den Anzeigewert um 1 vergroBern. Wenn das /imit erreicht ist,
muss dieser Wert auf 0 zuriickspringen: erhoehen()

Bemerkungen:

1.  Die Klasse Nummernanzeige wird spéter noch weitere Methoden besitzen,
aber diese sind vorerst die wichtigsten.

2. Inder folgenden Implementierung verzichte ich auf die Kommentare.

Dadurch werden die Abbildungen kleiner.

public class Nummernanzeige
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private int limit;
private int wert;

public Nummernanzeige(int 1imitH)

{
limit = limitH;
wert = 0;

3

public int gibWert()
{

3

return wert;

public void erhoehen()

{
}

wert = (wert + 1) % limit;

Abbildung 4.8: Quelltext der Klasse Nummernanzeige

Ubung 4.1:

Erzeuge in BlueJ ein Projekt Zeit0la. Implementiere die Klasse
Nummernanzeige. Schreibe zusitzlich ausreichende Kommentare.
Untersuche ihre Methoden mit Hilfe des Inspektors.

Formuliere schriftlich, was der Operator % berechnet. (Setze dazu den
Parameter anzeigeLimit probeweise auf den Wert 5.)

Die Anzeige der Digitaluhr soll eine Zeichenkette aus zwei Zeichen darstellen,
z.B. 03 : 05. Mit den obigen Methoden wirst du blof3 die Darstellung 3 : 5
erhalten. Deswegen wird die Methode gibAnzeigewert() implementiert. Diese
liefert den aktuellen Wert als Zeichenkette und fiigt auBerdem eine fithrende
Null ein, wenn der Wert unter 10 liegt.

public String gibAnzeigewert()

{
if(wert < 10)
return "0" + wert;
else
return "" + wert;
ks

Abbildung 4.9: Quelltext der Methode gibAnzeigewert() in der Klasse Nummernanzeige

Ubung 4.2:
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Fiige die Methode gibAnzeigewert() der Klasse Nummernanzeige hinzu.
Erzeuge ein Objekt und teste seine Methoden.

Du hast nun also eine Klasse erstellt, die zweiziffrige Nummern anzeigt. Ein
Objekt mit /imit = 24 stellt die Stundenanzeige, ein Objekt mit /imit = 60 stellt
die Minutenanzeige dar.

4.3 Die Klasse Uhrenanzeige
Was muss die Klasse Uhrenanzeige alles konnen?

1.  Sie muss die Zeitanzeige als String darstellen: aktualisiereAnzeige()
2. Sie muss diesen String als Wert zuriickliefern: gibUhrzeit()

Auch hier werden spiter noch weitere Methoden folgen.

public class Uhrenanzeige

{

private Nummernanzeige stunden;
private Nummernanzeige minuten;
private String zeitanzeige;

public Uhrenanzeige()

{
stunden = new Nummernanzeige(24);
minuten = new Nummernanzeige(60);
aktualisiereAnzeige();

3

public String gibUhrzeit()
{

3

return zeitanzeige;

private void aktualisiereAnzeige()

{ n n

zeitanzeige = stunden.gibAnzeigewert() +
+ minuten.gibAnzeigewert();

Abbildung 4.10: Quelltext der Klasse Uhrenanzeige

Im Konstruktor werden die beiden Objekte stunden und minuten vom Typ
Nummernanzeige erzeugt. Mit dem Operator new wird also ein neues Objekt der
angegebenen Klasse Nummernanzeige erzeugt und der Konstruktor dieser
Klasse ausgefiihrt. Der Konstruktor der Klasse Nummernanzeige
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public Nummernanzeige(int limitH)

besitzt den formalen Parameter int 1imitH. Deshalb miissen die new-
Anweisungen, die diesen Konstruktor aufrufen, jeweils einen aktuellen
Parameter vom Typ int iibergeben:

stunden = new Nummernanzeige(24);
minuten = new Nummernanzeige(60);

Wenn also ein Objekt der Klasse Uhrenanzeige erzeugt wird, so wird der
Konstruktor der Klasse Uhrenanzeige ausgefiihrt und dieser erzeugt automatisch
zwei Objekte der Klasse Nummernanzeige.

Damit wird die in Abbildung 4.6 dargestellte Situation erreicht.

Ubung 4.3:

Implementiere im Projekt Zeit0la die Klasse Uhrenanzeige und teste ihre
Methode gibUhrzeit(). Momentan liefert sie nur als Ergebnis 00:00.

O 00 Blug): Zeit0l
— Uhrenanzei
= -
e .
i
|
i Nummernanzeige
——————— —=
806 Blue): Method Result
——— |
inherted from Object ) Sing roouit | "00 - 00" | | Inspect |
Uhrenz_ String gibUhrzeit() £ Cet
Inspect
Remove Close

A

Abbildung 4.11: Klasse Uhrenanzeige mit ihrer Methode gibUhrzeit()

Nun musst du noch ein Taktsignal simulieren. In der realen Welt sollte dieses
jede Minute von einem Quarz erzeugt werden. In deinem Modell wirst du dich
selbst bemiihen miissen.

public void gibTaktsignal()
{
minuten.erhoehen();
if(minuten.gibWert() == 0) {
stunden.erhoehen();

}
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aktualisiereAnzeige();

Abbildung 4.12: Quelltext der Methode gibTaktsignal() in der Klasse Uhrenanzeige

Ubung 4.4:

Fiige die Methode gibTaktsignal() der Klasse Uhrenanzeige hinzu und teste ihre
Methoden ,.live* mit Hilfe des Inspektors.

OO0 Blue): Zeit0l1
=l
> | |
|
| Nummernanzeige
bomeee -
Blue): Object Inspector
-

—— uhrenanzi : Uhrenanzeige

private Nummernanzeige stunden -
private Nummernanzeige minuten Get
private 5tring zeitanzeige "00 : 04"

. Inspect |
o Sl

868 Blue): Object Inspector
d 3
\"': uhrenanzi minuten : Nummernanzeige
—
Insneact

private int limit | 60 | e
private int wert | 4 | Get
£ ot ciatiiFiatidc
. Show static fields ) @

-
[

Abbildung 4.13: Untersuchung der Klasse Uhrenanzeige mit Hilfe des Inspektors

4.4 Setzen der Uhrzeit
Noch ist die Digitaluhr nicht komplett, du kannst die Uhrzeit nicht einstellen.

Dazu musst du in der Klasse Nummernanzeige direkt auf das Datenfeld wert mit
einer verandernden Methode zugreifen. In einer Sicherheitsabfrage werden nur
sinnvolle Werte zugelassen.

public void setzeWert(int wertH)

{
if((wertH >= 0) & & (wertH < 1limit))
wert = wertH;
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Abbildung 4.14: Die Methode setzeWert() in der Klasse Nummernanzeige.

Ubung 4.5:
Erstelle in BluedJ ein neues Projekt Zeit01b. Dazu hast du zwei Moglichkeiten:

I. Im Meniipunkt Project > Save as... das urspriingliche Projekt unter dem
neuen Namen Zeit(01b abspeichern.

2. Ein neues Projekt Zeit01b erstellen und mit dem Meniipunkt Edit > Add
Class from File ... die Klassen aus dem urspriinglichen Projekt ZeitOla
tibernehmen.

Implementiere in der Klasse Nummernanzeige die Methode setzeWert() und
teste diese Klase Nummernanzeige mit Hilfe des Inspektors.

Nun musst du noch in der Klasse Uhrenanzeige eine Methode setzeUhrzeit()
implementieren. Diese Methode erhilt als formale Parameter stunde und minute.
Dann ruft sie die Methode setzeWert() der jeweiligen Objekte stunden und
minuten aus der Klasse Nummernanzeige auf und verdndert deren wert.

public void setzeUhrzeit(int stunde, int minute)

{
stunden.setzeWert(stunde);
minuten.setzeWert(minute);
aktualisiereAnzeige();
}
Abbildung 4.15: Die Methode setzeUhrzeit() in der Klasse Uhrenanzeige
Ubung 4.6:

Implementiere in der Klasse Uhrenanzeige die Methode setzeUhrzeit() und teste
sie mit Hilfe des Inspektors.

Bereits beim Erzeugen eines Objekts der Klasse Uhrenanzeige kann dieses auf
eine bestimmte Uhrzeit eingestellt sein. Dieses ,,automatische Einstellen* wird

mit Hilfe eines weiteren Konstruktors durchgefiihrt.

public Uhrenanzeige(int stunde, int minute)

{
stunden = new Nummernanzeige(24);
minuten = new Nummernanzeige(60);
setzeUhrzeit(stunde, minute);

ks

Abbildung 4.16: Ein weiterer Konstruktor in der Klasse Uhrenanzeige
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Ubung 4.7:

Implementiere in der Klasse Uhrenanzeige den neuen Konstruktor und teste ihn
mit Hilfe des Inspektors. (vgl. Abbildung 4.17)

(0

: ) Blue}: Zeit02

MNew Class.. T Uhrenanzeige

Nummernanzeige

_______ _} - - .
Blue): Create Object

B

Compile

# Konstruktor fuer efin Exemplar von Uhrenanzeige.
& Mit diesem Konstruktor wird die Anzeige auf den Werl
Hinittalisiert, der durch ‘stunde’und ‘minute’

| Adefiniert ist.
r—— Uhrenanzeige(int stunde, int minute)
uhrenanzi: Name of Instance: uhrenanzl
Uhrenanzeige new Uhrenanzeige( & 5 , int stunde
45 5 ) int minute
[ 8686 Blue): Object Inspector
1 P ~

uhrenanzi - Uhrenanzeige

|
private Nummernanzeige stunden sl
private Nummernanzeige minuten _Get

private String zeitanzeige "06:45"

{ Show static fields ) @

Abbildung 4.17: Konstruktor setzt die Uhrzeit

Ubung 4.8:

Vervollstindige nun das Projekt Zeit01b. Verwende Kommentare. Teste es
ausgiebig!
Was passiert, wenn du negative Zahlen verwendest?

Ubung 4.9

Programmiere eine Digitaluhr mit Stunden- Minuten- und Sekundenanzeige!

Ubung 4.10: (Fiir Experten)

Programmiere eine Digitaluhr mit Timer oder Alarm!
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4.5 Grafische Benutzeroberflache

Nachdem die Uhr nun funktioniert, kannst du dich der grafischen
Benutzeroberfliche widmen. Die Abbildung 4.18 zeigt eine einfach gestaltete
grafische Benutzeroberfliche. Diese wird in Java-Swing gestaltet.

Die Gestaltungsmoglichkeiten mit Swing werden im Handbuch der Java-
Programmierung von Guido Kriiger, im The JFC Swing Tutorial, Second
Edition von Kathy Walrtath, u. a oder in dhnlichen Biichern beschrieben.

Uhr

Uhrzeit:

00:00

start

stopp

ende

Abbildung 4.18: Einfache grafische Benutzeroberfliche der Digitaluhr

In Swing werden die Fensterkomponenten in einer Art Container, so genannte
Panels, gepackt. In der Abbildung 4.18 bezeichne ich den Teil des gesamten
Fensters, in dem gezeichnet werden kann (also ohne der Meniileiste) als
Hauptpanel mainP. Dieser Teil ist der hellrote Bereich.

Dieses Hauptpanel ist wiederum unterteilt in das

a) gelbe Zeitpanel zeitP mit einem Label und einem Textfeld
b)  blaue Buttonpanel buttonP mit den drei Buttons start, stopp und ende

Jeder dieser Button bekommt einen ActionListener, der das Anklicken
iiberwacht und dann die entsprechenden Aktionen auslost. Die Aktionen von
z.B. start werden in der Methode startAction() implementiert, somit kann die
Uhr starten.

Ubung 4.11:

Hole vom Schulserver das Projekt ZeitGUI und speichere dieses als Projekt
Zeit02. Studiere den Quelltext der Klasse Ansicht. Suche die Komponenten
zeitTF und start.
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In vielen grafischen Oberflachen wird die Anordnung der Komponenten durch
Angaben absoluter Koordinaten vorgenommen. Da jedoch Java-Programme auf
unterschiedlichen Plattformen laufen sollen, ist eine solche Vorgehensweise
nicht sinnvoll. Zur Anordnung der Komponenten verwendet man in Java
verschiedene so genannte Layoutmanager. Diese sorgen dafiir, dass die
Benutzeroberfliche auf allen Plattformen das gleiche Aussehen hat
(weitestgehend).

Ich verwende in diesem Beispiel den GridLayout-Manager und den BoxLayout-
Manager. Im GridLayout werden die Komponenten innerhalb eines
rechteckigen Gitters angeordnet. Die Parameter beim Aufruf des Konstruktors
bestimmen die vertikale und die horizontale Anzahl der Elemente. Im
BoxLayout werden die Komponenten standardméfig untereinander in der
bendtigten Grofle angeordnet. Weitere Einzelheiten werden in den oben
genannten Biichern beschrieben.

Die folgenden Ubungen werden dich schrittweise vertraut machen mit der
Programmierung von grafischen Oberfldchen in Java. Zum Schluss wirst du eine
Oberflache programmiert haben wie in Abbildung 4.18 dargestellt. Verwende so
oft wie moglich das Verfahren ,,Copy and Paste*!

Ubung 4.12:

Andere in der Methode setTitle() das Argument ,, Test” um in ,,Uhr*.

Andere in der Methode setBounds() die urspriinglichen Werte (50, 50, 150, 230)
in (300, 200, 400, 250) bzw. in (50, 50, 600, 400). Formuliere schriftlich, welche
Verdanderungen dadurch stattfinden. Setzte in der Methode setBounds() wieder
die urspriinglichen Werte ein.

Ubung 4.13:

Das zeitP soll nun den zusitzlichen Text ,,Uhrzeit:* enthalten.. Bezeichne das
neue Label als zeitL und fiige es analog dem Textfeld zeitTF dem Zeitpanel
hinzu. Vergiss nicht den zusitzlichen Eintrag im Variablenkatalog.

Ubung 4.14:

Andere den Text des Buttons in ,,start*.

Ubung 4.15:

Fiige nun die beiden weiteren Button stopp und ende hinzu. Vergiss nicht die
entsprechenden ActionListener-Methoden, auch wenn diese noch leer sind.

Verindere probeweise die letzten beiden Werte 5 in der Parameterliste der
Anweisung new GridLayout(0, 1, 5, 5); in die Werte 20. Formuliere die
Bedeutung dieser beiden Parameter.
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Nach Abschluss dieser Ubungen sollte das Fenster des Projekts Zeit02 der
Abbildung 4.18 gleichen.

4.6 Verbindung zwischen Uhrenanzeige und Ansicht

Das Digitaluhr-Projekt ist also in zwei grof3ere Teile zerlegt worden: Der eine
Teil (die in Kapitel 4.5 erstellte Benutzeroberfldche) ermoglicht dem Benutzer,
die Uhr mit Hilfe der Buttons zu steuern, der andere Teil (die in Kapitel 4.3
erstellte Uhr Zeit01a) implementiert die arithmetische Logik fiir die
Berechnungen der Uhrzeit.

Benutzer= Arithmetische

oberflache [ :J] Logik

Abbildung 4.19: Festlegung der Schnittstelle

Die Abbildung 4.19 zeigt, dass fiir beide Teile klar definiert sein muss, wie sie
den jeweils anderen Teil benutzen konnen — die Schnittstelle zwischen ithnen
muss definiert werden. In groBeren Projekten muss es also klare Richtlinien
geben, welches Entwicklungsteam fiir welche Aufgaben zustandig ist und wie
die verschiedenen Teile schlieBlich in der Gesamtanwendung zusammenspielen
sollen. Es wird also notwendig sein, die Schnittstellen festzulegen, bevor an der
Implementierung der Teile gearbeitet werden kann.

In dieser Einfiihrung des Projekts habe ich aus didaktischen Griinden den
umgekehrten Weg beschritten.

Damit die Digitaluhr auch mit Hilfe der Buttons bedient werden kann, musst du
in der Klasse Ansicht noch einen Timer einfiihren. Im Konstruktor erzeugst du
den Timer timer.

timer = new Timer(1000, new ActionListener() {
public void actionPerformed(ActionEvent e) {
timerAn O;
ks
s
Abbildung 4.20: Erzeugung des Timers timer im Konstruktor der Klasse Ansicht
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Alle 1000 ms ruft dieser Timer timer die Methode timerOnT() auf, deren
Anweisungen dann durchgefiihrt werden.

Bemerkung:

Hier wird ein Timer verwendet, der alle 1000 ms eine Aktion durchfihrt. Das
Projekt ZeitO1a/b verwendet jedoch Stunden und Minuten. Hier machst du also
noch einen Fehler, der jedoch in Ubung 4.19 beseitigt wird.

Die Methode timerOnT() wird vorlaufig noch leer gelassen.

private void timerAn()

{
//leer
3
Abbildung 4.21: Die Methode timerOnT() in der Klasse Ansicht
Ubung 4.16:

Erstelle in BlueJ ein neues Projekt Zeit(03a. Mit Hilfe des Meniipunkts Edit >
Add Class from File ... ibernehme die Klasse Ansicht aus dem Projekt Zeit02
und die Klassen Uhrenanzeige und Nummernanzeige vom Projekt Zeit01a.

Nun implementiere den Timer in der Klasse Ansicht.

Blue): ZeitD3a

Mew Class... Ansicht

@

! @)

‘QL v &
i

Compile Uhrenanzeige

r“——
v

Hummernanzeige

R

-

Initialising virtual machine... Done y

Abbildung 4.22: Klassendiagramm von Zeit03a
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In der Klasse Ansicht existieren nun vier leere Aktion-Methoden fiir die drei
Buttons und fiir den Timer. In diese Methoden legst du nun die entsprechenden
Aktionen.

private void startAction()

{
timer.startQ);
ks
private void stoppAction()
{
timer.stop();
ks
private void endeAction()
{
timer.stop();
System.exit(0);
ks
private void timerAn()
{
uhr.gibTaktsignal(Q);
zeitTF.setText(uhr.gibUhrzeit());
ks

Abbildung 4.23: Die vier Aktions-Methoden

Der Button start startet den Timer, entsprechend stoppt der Button stoppB den
Timer. Um die Anwendung mit endeB zu beenden, muss der Timer zuerst
gestoppt und dann die Anwendung verlassen werden.

Alle 1000 ms wird vom Timer die Methode timerOnT() aufgerufen. Diese gibt
der Uhr das Taktsignal und schreibt die aktuelle Zeit dann in das Textfeld
zeitTF:

Ubung 4.17:

Implementiere im Projekt Zeit03a die vier Aktions-Methoden aus Abbildung
4.23 in der Klasse Ansicht.

Ubung 4.18:
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Speichere das Projekt Zeit03a unter dem Namen Zeit03b und implementiere
zusitzlich eine Methode, die die Uhr auf,,00:00* zuriickstellt. Verwende dazu
das Projekt Zeit01b.

806 un

Uhrzeit:

01:16

start

stopp

null

ende

Abbildung 4.24: Projekt Zeit03b kann die Uhr auf Null zuriicksetzen.

Ubung 4.19:

Implementiere nun ein Projekt Zeit03c, das die Stunden, Minuten und Sekunden
zihlt. Beachte hierzu die Bemerkung und Ubung 4.9.
Hast du schon tiberpriift, wie genau diese Uhr geht?

4.7 Java ohne BluedJ

Du hast BlueJ verwendet, um eine Java-Anwendung zu entwickeln und
auszufiihren. Dafiir gibt es auch einen guten Grund: BlueJ bietet einige
Werkzeuge, die typische Aufgaben bei der Entwicklung erleichtern.
Insbesondere ermdoglicht BlueJ die direkte Ausfithrung einzelner Methoden von
Objekten — das ist niitzlich, um schnell ein neues Stiick Quelltext zu testen.

Anwendungen, die an Benutzer ausgeliefert werden, werden ohne Bluel
gestartet. Man bezeichnet solche Anwendungen als stand-alone-Applikation. Sie
haben tiblicherweise einen Einstiegspunkt, an dem die Ausfithrung beginnt,
wenn der Benutzer die Anwendung mit einem Doppelklick auf ein Icon startet.
Das Java-System sucht dann nach einer Methode mit der folgenden Signatur:

public static void man(String[] args)

Der Name main wurde willkiirlich von den Java-Entwicklern gewéhlt, steht
jedoch fest: Die Methode muss so heiflen!
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Um aus dem Projekt Digitaluhr eine ausfithrbare Anwendung zu machen,
benotigst du also

1.  eine Klasse, die die Methode main() enthilt,

2. einen Mechanismus, der alle Teile eines Projekts zu einer einzelnen Datei
zusammenfasst, zum so genannten Java Archive Format (jar)

public class Simulation

{
Ansicht ansicht;
public Simulation()
{
ansicht = new Ansicht();
ks
public static void main(String[] args)
{
Simulation gq = new Simulation();
ks
ks

Abbildung 4.25: Die Klasse Simulation enthdlt die Methode main()

Die Abbildung 4.25 zeigt, dass die Klasse Simulation die Methode main()
enthilt. Wird die Methode main() also aufgerufen, wird ein Objekt g (Name ist
von mir willkiirlich gewihlt) der Klasse Simulation erzeugt. Der Konstruktor
von g erzeugt das Objekt ansicht der Klasse Ansicht, also genau das, was du
bisher immer manuell in BlueJ getan hast.

Die Abbildung 4.26 zeigt, wie die Methode main() in BlueJ aufgerufen wird

63 Gymnasium Konigsbrunn Ralph Henne



Kapitel 4 Das Projekt Digitaluhr Seite 18

S 0o Blue): Zeit03c
— new Simulation()
=
; void mainiString[] args)
—_| Open Editor
Compile i Compile
| Inspect
' Uhrenanzeige P i
[ Remove

Ziffernzeige

Lo

Abbildung 4.26: Aufruf der Methode main()

Ubung 4.20:

Erstelle die Klasse Simulation und teste die Methode main().

Um eine ausfiihrbare jar-Datei in BlueJ zu erstellen, musst du im Menii Project
den Meniipunkt Create Jar File... aufrufen. Im folgenden Dialog wahlst du die
Klasse, die die Methode main() enthilt, in diesem Fall also die Klasse
Simulation. Optional kannst du noch entscheiden, ob du dem Benutzer den
Quelltext und die BluelJ Project-Dateien mitliefern willst. AnschlieBend gibst du
der jar-Datei noch einen geeigneten Namen und legst den Speicherort fest.

H ™ Blue): Create Jar File

Create a single java archive {jar) file containing
the project. Executable if main class is specified.

Main class: v none (cannot be executed) d
Ansicht

[ Include

Uhrenanzeige
[ Include | i gl
Ziffernzeige

(Continue) Ir Cancel w‘

F
Abbildung 4.27: Erstellen einer jar-Datei
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Ubung 4.21:
Erstelle eine jar-Datei Digitaluhr.jar.

Beende anschlieBend BlueJ und teste, ob Digitaluhr.jar eine stand-alone-
Applikation ist.
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